

THE INTEGRATION OF GPS, EXPERTGPS, EXCEL, AND ARCGIS IN GEOLOGICAL MAPPING AND DATA MINING:

GOOGLE EARTH TO ARCGIS TO GOOGLE EARTH

SUMMARY


The complexity of the following procedure reflects that fact that GPS waypoints/tracks may need to be plotted in Google Earth either directly, or indirectly via MNRSGarmin, and in ArcGIS either directly with MNRSGarmin as an ArcGIS extension, or via a .dbf file created within an EXCEL database containing not only the coordinate data for the waypoints but also a full set of attributes related to the waypoints.


1) Set up a working directory (e.g. arccampus) to include the following folders:

Airphoto  - for UNREGISTERED images,

Excel      - for EXCEL (.XLS and .DBF) and ExpertGPS (.gpx) files, including the .xls masterfile.

rectify     - for rectified images.

shape     - for ArcGIS shapefiles.

layer       - for ArcGIS layers.

ref_pnts  - for reference points used to georegister the airphoto.

Kml        -  for Google Earth kml files generated in ArcGIS


2) Load Google Earth (GE) and add a set of placemarks, to act as coordinate markers for the area of interest.


3) Collect a screen shot of the desired GE image – use a screen capture program such as SNAGIT, or e-mail the image to yourself from within GE.


4) Bring the image into ArcGIS, georeference it, create a grid and make a gridded and conveniently scaled hardcopy.


5) Collect field data including GPS waypoints.


6) Download waypoints directly to Google EarthPlus or download to EASYGPS or  EXPERTGPS or  MNRSGarmin, and save to a .gpx file (if importing indirectly into Google Earth).


7) If using EXPERTGPS and exporting to EXCEL set ‘Columns’, and export waypoints to a .csv file. If using MNRSGarmin the waypoint data can be exported as .gpx or ,csv.  If using EasyGPS the waypoint data can only be saved as a .gpx file. To create a .csv file in this case the .gpx output by EASYGPS would have to be imported into MNRSGarmin and then re-output as a .csv.


8) If creating a .dbf database in EXCEL load the .csv file (and PERSONAL.XLS file) into Excel, add ‘outcrop’ ‘Traverse’ and ‘Geologist’ fields and run the Garmin Macro to reformat the fields.


9) Copy the data set to the master database file.


10) Add structural (strike, dip, plunge, younging), lithological, chemical, etc, data (attributes) to the EXCEL master folder, and save the master file as both .xls and .dbf


11) Load ARCGIS and assign the correct map projection to the data frame.


12) Add the EXCEL .dbf data file to the ARC MAP document, and create 'outcrop number' labels for the data points.


13) Add the structural data to the ARC MAP document.


14) Setup the Symbiology and Labels to be used in plotting oriented symbols for the various structural 'features' (bedding, foliation, dikes, younging).


15) Setup the shape files and layers to be used in drawing geological boundaries and creating lithologic polygons.


16) On the 'all line' layer draw in the lines representing geologic boundaries.


17) Create polygons on an ‘allpolygon’ layer from the lines in the Lines shape file using ET Geowizards (see http://www.ian‑ko.com/  ‑ ET Geo Wizards).


18) Copy and Paste the polygons sets representing different lithologies from the ‘allpolygon’ layer to their relevant lithologic layer.

Acronyms: DC = double click (Layer Properties); RC = right click; TB = Toolbar; TOC = Table of contents.

19) Convert the various shape file databases to .KML files.


20) Load the kml files into Google Earth.

Layer - In ArcGIS, a reference to a data source, such as a shapefile, coverage, geodatabase feature class, or raster, that defines how the data should be symbolized on a map. Layers can also define additional properties, such as which features from the data source are included. Layers can be stored in map documents (.mxd) or saved individually as layer files (.lyr). Layers are conceptually similar to themes in ArcView 3.x.

Shapefile - A vector data storage format for storing the location, shape, and attributes of geographic features. A shapefile is stored in a set of related files and contains one feature class.

PROCEDURE

ASSUMPTIONS

It is assumed that we wish to avoid the annual subscription of $20 to Google EarthPlus (which would allow direct download of waypoint/track data to Google Earth), as well as the cost of commercial software for the purpose of transcribing file systems, and that we have a copy of ArcGIS provided by our educational institute or employer!!

SETTING UP FOLDERS

Create a folder e.g. ‘arc_campus’ for the project, and within ' arc_campus ' create:

a sub folder 'images' for images such as airphotos, satellite imagery, Google Earth images, etc.

a subfolder EXCEL to archive the .gpx, .xls, dbf files generated in Excel (coordinate data originally from ExpertGPS). Copy the EXCEL master folder .dbf to the EXCEL folder.

a sub_folder rectify for any rectified image created during the georegistration process.

a sub_folder shape for point, line and polygon shape files.

a sub_folder ref_pnts for the reference points that were used to georegister the image

a sub_folder layer for layers generated in ARCGIS9.

a sub_folder KLM for .kml files generated by the ArcGIS extension ‘Export to Google Earth KLM’.

OBTAINING AN IMAGE FROM GOOGLE EARTH

Load Google Earth and locate your area of interest. Create a folder named ‘Georef_Coords’ and insert a set of placemarks (7) conveniently distributed within the image. Name the way points with the lat-long values given in the Placemark ‘Property’ context window. 

Collect a JPG screen shot of the desired GE image – use a screen capture program such as SNAGIT, or e-mail the image to yourself from within GE. Save the image in your ‘images folder.

ADDING THE GE IMAGE OR OTHER AIRPHOTO/SATELLITE IMAGES TO ARCMAP


If the intent is to load a Google Earth (GE) image into ArcGIS, add a set of placemarks to the image in GE and title each placemark with the lat, long of the relevant location. Carry out a screen capture with Snagit or some other software, or e-mail the image to yourself.

Load ArcCatalog and locate the relevant GE image. RC the file name and click ‘Properties’. In the ‘Raster Dataset Properties’ window, cursor down to ‘Spatial Reference’ and click the ‘Edit’ button.

In the ‘Spatial Reference Properties’ windows click the ‘Select’ button and in the ‘Browse for Coordinate system’ select ‘Geographic Coordinates System’  -> World -> WGS 1984.prj. with the ‘Add’ button, followed by ‘Apply’, and ‘OK’. The Spatial reference for the image will now be set. Click ‘Apply’, and ‘OK’.  A file with the suffix filename.aux.xml will be added to the image folder.


Load ARCMAP

Optionally change the name of the data frame from 'Layers' to a recognizable name such as 'Campus'. 

DC the Layer icon in the TOC to get the 'Data Frame Properties'. In ‘General’ ‘Units’ set the ‘Map’ and ‘Display’ to Decimal degrees.   Click the tab 'Coordinate System' ‑> Predefined ‑> 'Projected Coordinate systems' to set the coordinate system to lat, long WGS1984. Click APPLY and OK.  

Click the ADD icon, select the name of the aerial photo to be loaded (e.g. campusgrd, and click ADD (or drag and drop the airphoto shapefile from the ARCGIS CATALOG).

If the image is a .geotiff or MrSid, the image will already be georeferenced, and nothing further needs to be done.  However, if the image is a GE image or other unreferenced image you may probably find that you will need to stretch the image in order to make it less dark. In this case right click the image layer in the TOC and select Properties. Then select Symbology. In the stretch selection box select ‘Histogram Equalize’ as Type -> click the Histogram button and in the histogram graph drag the top of the diagonal line towards the left to cause the histogram pattern to be stretched towards the right. Do this in stages clicking the ‘Apply’ button at the bottom right at each stage in order to see the results of the stretch. Continue until you are satisfied with the result.

If you have loaded a Landsat image derived from GEOGRATIS you may want to select (trim) a smaller area within the image. Zoom into the area to clip. The portion of the raster dataset that is displayed on the screen is the data that will be exported. In the table of contents, right‑click on the current raster dataset, point to Data, and click Export Data. 

The Export Raster Data dialog box appears. In the Extent section, click the Data Frame radio button. Select the output location for the raster export, the name of the output raster, and the file format. Click Save to export the raster. Once the operation is completed, click Yes to display the clipped raster dataset in ArcMap. Delete the old raster dataset, and save the new document under the old or a new .mxd name.  The image file will be much smaller and operations will be much faster.

If  the image is a JPG image it will need to be georeferenced and rectified. In this case use the Georeference tool bar as follows:

Click the 'View Link Table" icon to load the Link Table. Click the 'Add Control Points' icon, move the cursor to a known (x and y coordinates) location on the image and without moving the cursor click twice (do not double click)  The first click selects the control point, the second click enters the coordinate values to the Link Table). Repeat to add a second and third (fourth, fifth, etc) control point. Change the values in the Xmap and Ymap columns to the real UTM coordinate values for each location, and then click OK.

TIP: select a set of locations on the image that you can also recognise in Google Earth. Record the UTM locations of the points as provided by Google Earth. Record the coordinate values for the same locations provided by ArcGIS, and create a simple text file of the kind, e.g.:

45.164428 
-18.408530
477700.000000
4761900.000000

444.007260
-21.115608
478000.000000
4761900.000000

444.007260
-432.591470
478000.000000
4761600.000000

where the first two values in each row are the ArGIS X and Y values, and the second two values are the Google Earth UTM X and Y values. Save the file and in the Link Table on the Georeferencing toolbar click the 'LOAD' button and select the relevant text file. The contents of the file will be added to the Link Table.

If the original image was not orthogobal, in the 'Georeferencing' drop‑down list select 'Rectify', and save the new .tif image as 'rec…. in e.g. \arc_campus\rectify.  The georeferencing changes will be made permanent in the rectified image, but not in the original image archivd in \arc_campus\airphoto.

ADD 'rec……' to the TOC, and remove the original jpg image.  Repeat for any other images.

TO PRINT THE AIRPHOTO WITH A GRID AND TO SCALE ON 11 X 8.5 PAPER

DC 'Layers' in the TOC to get the DATA FRAME PROPERTIES. Click the GRIDS tab ‑> New Grid ‑> Measured Grid and follow the instructions to set up the grid..

In DATA FRAME PROPERTIES select 'Data Frame' and in 'Extent' change 'Automatic' to 'Fixed Scale', adding a value of 1: 10000. 

Click the Layout View icon to enter Layout View.  The image can be moved within the limits of the 11 x 8.5 inch page by using the PAN tool.

COLLECT DATA

DOWNLOADING WAYPOINT DATA FROM THE GPS UNIT


Google Earth Plus ($20)


To download waypoints and tracks from the Garmin unit, the interface in the Garmin should be set to "Garmin" or "NMEA" according to whether you are downloading waypoints or tracks (set to Garmin) or whether you are using Realtime tracking (set to NMEA). 


Tools ‑> GPS ‑> select Historical or Realtime


Historical ‑> under "Device" select Garmin or Magellan as your GPS unit ‑> under "Import" select Waypoints and/or Tracks (or Routes) ‑> under "Options" select "Icons at Track and Route points" &/or "Lines at Track and route points" ‑> Ground Height


‑> Click IMPORT . Google Earth will search for the active port and import both Waypoint and track data if both were selected under "Import". Simple to carry out but costs an annual fee of $20.


Realtime Tracking‑> chose NMEA or Garmin  PVT


Set "Track import limit" (e.g. 9) and Polling Interval (e.g. 4 secs). Click the Start button. The marker will be a green ballon. The position of the icon moves as you change location but the track is not displayed. The track recorded in the GPS unit can however  be downloaded by choosing Historical.


ARCGIS 9.2 (ArcMap) $1500


To download waypoints and tracks in realtime from the Garmin unit, set the interface in the Garmin to "NMEA". 

   
View ‑> Toolbars ‑> GPS ‑> insertion of GPS toolbar in the toolbars


GPS connection set up:

   
Set the communication port to COM3 at 4800 baud, Data Bits = 8, Stop bits ‑= 1, Parity = none, and datum as GCS WGS1984.   Set the Datum to be used by the imported data (which in the case of Garmin is always decimal degrees).

  
Use "Display options ‑ General to select the icon and colour of the current display position (right click the default black arrow head).  Select "Trails" to set under "Marker Trail" the symbol, colour ramp, number of trailing point (1000), Distance between points (10 metres) Total distance is 10 km. 


For "Linear Trail"  change the symbol to a a red "road" line with a total lenght of 10000 metres.

 
Click the "Open Connection" icon on the toolbar to start collecting waypoints.


You can also collect streamed data in a .shp file after setting up a log for point or line data (Cannot put both lines and points in the same file.)


The following link allows download of 'Export to KML 2.4.2, an ARCGIS extension that allows export of shape files (points, lines and polygons)  to kml.  Need to use ARCcatalogue to specify  the coordinates of the shape file, if the shapefile is not already associated with a coordinate system.

http://arcscripts.esri.com/details.asp?dbid=14273 


ExpertGPS  (EasyGPS $0; no map image)


Connect the COM1 serial cable to the Brunton/Garmin. (If using a Belkin RS232 to USB converter, the Belkin drivers must be loaded, and the Belkin unit (depending on the model and driver) may need to be attached before turning on the computer.) 

Turn on the Garmin. (When downloading from the Brunton, both the Brunton and the GPS function must be ON; if the first attempt to download fails, try a second time.)


To download previously recorded waypoints and tracks from the Garmin unit, set the interface in the Garmin to "Garmin" GPS unit, select GPS in the toolbar ‑> select "Receive from GPS"  ‑> select Waypoints and/or tracks, and note that the GPS box states Garmin Etrex. Click OK to initiate the download. Saving as a .gpx file will incorporate both waypoints and tracks in a single file. If using EasyGPS to import  waypoints and tracks, the coordinate information for the waypoints will be shown.  The data coordinates for the tracks will however not be listed, although the trace of the tracks will appear in the dataframe (image window).  When exported (dragged) into Google Earth the waypoints and the tracks will appear as separate 'Waypoints' and 'Tracks' folders.


The 'Waypoint' folder will contain a list of waypoints where the 'Tracks'  folder will contain both a 'Points' folder containing the coordinates of the interstices of the path and a 'Path folder containing the line of the path (Track).


Real Time Tracking


To track your current itinerary set your Garmin to NMEA,  then in ExpertGPS select Tracking in the Toolbar ‑> Preferences = "NMEA GPS Active" (not Garmin as in the case of the Waypoint download); COM ?; 4800 Baud


The active and saved tracks will be drawn. The tracks can be saved in Tracking ‑>"Tracking options" ‑> Save. The track will appear as "Current Tracklog" under "Type" in the Tracks List window (left‑hand window). It can be save as a gpx file. The track can also be saved in the Garmin GPS unit without the latter being attached to the computer, and subsequently downloaded to the computer via the GPS ‑> "Receive from GPS" option, as described above in GPS . Note: .gpx files can be dragged into the Google Earth List menu.

EasyGPS ($0)


Load EasyGPS, select  Edit -> Preferences, and set the Units of Measure, the Coordinate System used by your waypoints, the GPS unit used, and, in ‘Settings’ indicate the port and data download speed being used by the unit for the unit.  Click the GPS icon in the toolbar  -> ‘Receive from GPS’ to begin the download. The same transfer speed must be set in the GPS unit and EasyGPS  - this usually means they must have the same transfer rate set for the interface (e.g. 9600 for Garmin or 4800 for the NMEA interface) must be set in both the GPS unit and EasyGPS.


MDNR ($0)

http://cda.morris.umn.edu/~jonesjv/gis/labs/lab7.html ‑ see 


Note:  waypoints, tracks, and real‑time tracks are downloaded as separate events, and saved as separate .gpx files for transfer to Google Earth, at which point they are treated as described above in ExpertGPS (EasyGPS) ‑> GPS. The advantage of MDNR is that the coordinate values of Waypoint and track interstices are displayed in tabular format, and can be edited.  The minor disadvantage is that the waypoints and tracks have to be saved as individual .gpx files. If the .gpx files need to be retained as data backup files, this may be an advantage.

MANIPULATING THE DATA IN EXCEL

Expert GPS Version 2.2 (latest version)

In ExpertGPS click the empty space in the Waypoints window (left hand side) and select ‘View’ in the toolbar -> Select Columns (near bottom of the option list) -> check the  Description,  Waypoint,  Coordinates, and Elevation boxes ONLY.  Then export the data:  File ‑> Export ‑> Save As as a .txt file, e.g. aauwo'yourinitials'.txt. The fields exported from ExpertGPS are tab-delimited fields:

Description

Waypoint

Coordinates X, Y, and Zone

Elevation


Open the .txt file in Excel and in the ‘Text Import Wizard’ make sure that ‘Delimited’ is chosen as file type in step 1 of the Wizard procedure, and that ‘Tab’ is chosen as the delimiter in step 2; click ‘FINISH’.

In column 8 add the string  ‘outcrop’, in column 9 add a Traverse ('Travnum') field with the value, e.g. 3090127 (3 = year, 09 = month, 01 = student [a number will be assigned to you], 27 = day) entered into all the cells, and in column 10 add a 'Geologist' field with the numerical value that has been assigned to you, e.g. '1', in all rows. Save the file.

The columns and cell values can now be manipulated into a form suitable for import into Fieldlog by running an EXCEL macro that will carry out the manipulation.

EXCEL MACRO 


Load into EXCEL the supplied file personal.xls 

Run the Garmin macro by selecting TOOLS ‑> Macro ‑> Macros ‑> Personal.XLS!Garmin (or Brunton). The macro is contained in the  'personal.xls' file.

The macro will create a STATION field numeric value in which each value will have the form, e.g. 309012701, where 3 = the year 2003, 09 the month, 01 = the geologist, 27 = the day, and 01 = the order in which the stations (outcrops) were collected on that day.

Load the file campus.xls into EXCEL and Cut and Paste the modified data set into the STATI Table section (1st Table) of campus.xls.  This will provide you with an EXCEL record of your data set that you can subsequently upgrade with information from your field notes as needed.

In the master file the data is organized as a set of fields (columns) grouped into a set of Tables. The Table and Field order is:

STATI: Statnum, UTMX, UTMY, UTMZ, Long, Lat, Elevation,  Statype, Travnum, Geologist, Airphoto, Outcrop, Sketch/Photo, Comment, and UTM Zone.  (The Elevation field is not used in this exercise.)

STRUCTURE: Statnum, UTMX, UTMY, STRUCFEATURE, Azimuth, Dip, Top direction

TRAVERSE: Statnum, NTS Map, Field dates, Summary

LITHOLOGY: Statnum, Rock #, Rock Type, Metals, Weathered colour, Fresh Colour, Describe, Comments

SAMPLE: etc

Add your structural and lithologic data to the .xls master file.

In the campus.xls file do a Format ‑> Column ‑> Autofit on the columns and save the file as an XLS file.  Delete the first row and make sure that all the records in any given column are of the same type. Save the modified file as, e.g. 'campus.dbf'.

ARCMAP


‘THE ESSENTIALS’:


Airphotographs are added using the ‘ADD’ tool.


The EXCEL database is added as an ‘…..Event’ layer using the ‘Add XYdata’ tool.

Symbols (waypoints, bedding, foliation, joints, dikes, etc) are added by exporting shape files via the ‘…..Events’ layer.

Line and Polygon layers (geologic boundaries, faults, lithology polygons) are added using the ‘New’ ‘shapefile’ function in ArcCatalog.


Lines are added using the Edit and Draw tools.

Polygons are created using the ArcGIS Editor and either the ETGeoWizard tool or the ArcGIS Topology tool.

ADDING AIRPHOTO IMAGES TO ARCMAP


If the intent is to load a Google Earth (GE) image into ArcGIS, add a set of placemarks to the image in GE and title each placemark with the lat, long of the relevant location. Carry out a screen capture with Snagit or some other software, or e-mail the image to yourself.

Load ArcCatalog and locate the relevant GE image. RC the file name and click ‘Properties’. In the ‘Raster Dataset Properties’ window, cursor down to ‘Spatial Reference’ and click the ‘Edit’ button.

In the ‘Spatial Reference Properties’ windows click the ‘Select’ button and in the ‘Browse for Coordinate system’ select ‘Geographic Coordinates System’  -> World -> WGS 1984.prj. with the ‘Add’ button, followed by ‘Apply’, and ‘OK’. The Spatial reference for the image will now be set. Click ‘Apply’, and ‘OK’.  A file with the suffix filename.aux.xml will be added to the image folder.


Load ARCMAP

Optionally change the name of the data frame from 'Layers' to a recognizable name such as 'Campus'. 

DC the Layer icon in the TOC to get the 'Data Frame Properties'. In ‘General’ ‘Units’ set the ‘Map’ and ‘Display’ to Decimal degrees.   Click the tab 'Coordinate System' ‑> Predefined ‑> 'Projected Coordinate systems' to set the coordinate system to lat, long WGS1984. Click APPLY and OK.  

Click the ADD icon, select the name of the aerial photo to be loaded (e.g. campusgrd, and click ADD (or drag and drop the airphoto shapefile from the ARCGIS CATALOG).

If the image is a .geotiff or MrSid, the image will already be georeferenced, and nothing further needs to be done.  However, if the image is a GE image or other unreferenced image you may probably find that you will need to stretch the image in order to make it less dark. In this case right click the image layer in the TOC and select Properties. Then select Symbology. In the stretch selection box select ‘Histogram Equalize’ as Type -> click the Histogram button and in the histogram graph drag the top of the diagonal line towards the left to cause the histogram pattern to be stretched towards the right. Do this in stages clicking the ‘Apply’ button at the bottom right at each stage in order to see the results of the stretch. Continue until you are satisfied with the result.

If you have loaded a Landsat image derived from GEOGRATIS you may want to select (trim) a smaller area within the image. Zoom into the area to clip. The portion of the raster dataset that is displayed on the screen is the data that will be exported. In the table of contents, right‑click on the current raster dataset, point to Data, and click Export Data. 

The Export Raster Data dialog box appears. In the Extent section, click the Data Frame radio button. Select the output location for the raster export, the name of the output raster, and the file format. Click Save to export the raster. Once the operation is completed, click Yes to display the clipped raster dataset in ArcMap. Delete the old raster dataset, and save the new document under the old or a new .mxd name.  The image file will be much smaller and operations will be much faster.

If  the image is a JPG image it will need to be georeferenced and rectified. In this case use the Georeference tool bar as follows:

Click the 'View Link Table" icon to load the Link Table. Click the 'Add Control Points' icon, move the cursor to a known (x and y coordinates) location on the image and without moving the cursor click twice (do not double click)  The first click selects the control point, the second click enters the coordinate values to the Link Table). Repeat to add a second and third (fourth, fifth, etc) control point. Change the values in the Xmap and Ymap columns to the real UTM coordinate values for each location, and then click OK.

TIP: select a set of locations on the image that you can also recognise in Google Earth. Record the UTM locations of the points as provided by Google Earth. Record the coordinate values for the same locations provided by ArcGIS, and create a simple text file of the kind, e.g.:

45.164428 
-18.408530
477700.000000
4761900.000000

444.007260
-21.115608
478000.000000
4761900.000000

444.007260
-432.591470
478000.000000
4761600.000000

where the first two values in each row are the ArGIS X and Y values, and the second two values are the Google Earth UTM X and Y values. Save the file and in the Link Table on the Georeferencing toolbar click the 'LOAD' button and select the relevant text file. The contents of the file will be added to the Link Table.

If the original image was not orthogobal, in the 'Georeferencing' drop‑down list select 'Rectify', and save the new .tif image as 'rec…. in e.g. \arc_campus\rectify.  The georeferencing changes will be made permanent in the rectified image, but not in the original image archivd in \arc_campus\airphoto.

ADD 'rec……' to the TOC, and remove the original jpg image.  Repeat for any other images.

TO PRINT THE AIRPHOTO WITH A GRID AND TO SCALE ON 11 X 8.5 PAPER

DC 'Layers' in the TOC to get the DATA FRAME PROPERTIES. Click the GRIDS tab ‑> New Grid ‑> Measured Grid and follow the instructions to set up the grid..

In DATA FRAME PROPERTIES select 'Data Frame' and in 'Extent' change 'Automatic' to 'Fixed Scale', adding a value of 1: 10000. 

Click the Layout View icon to enter Layout View.  The image can be moved within the limits of the 11 x 8.5 inch page by using the PAN tool. 

PLOTTING STATION SYMBOLS AND LABELS FROM A .DBF FILE

Load ARC Map and the relevant document, and in 'Tools' ‑> 'Add X Y data' and in 'Add XY data' browse and select 'campus.dbf'.  SpecifyUTMX and UTMY as the X and Y coordinates, respectively, and indicate the coordinate system to be used by clicking the Edit button ‑> Select ‑> Projected Coordinate systems ‑> UTM – WGS84 UTM Zone 17N. Click ADD and then Apply and OK. 

'Campus Events' will appear in the TOC. 

RC ‘campus Events' and select DATA ‑> Export data.  Export the new shape file as 'stati.shp' to \campus\shape.  When asked “Do you want to add the exported data to the map as a a layer, answer ‘YES’.

To add an 'Outcrop number' as a label, DC 'stati’ in the TOC to get the 'Layer Properties'. Select 'Labels' ‑> check the 'Label features in this layer box ‑> select 'Label all the features the same way' as the 'Method' ‑> select OUTCROPNUM as the 'Text String Label Field' (OR STATNUM for the full station identifier). In the Placement Properties option box select low for 'Label Weight' and check 'Place overlapping labels'. Click APPLY and then OK if the plot is satisfactory.

SETTING THE REFERENCE SCALE

Double click the ‘campus’ layer to get the 'Layer Properties', and enter '0' as the value in 'Reference scale'. The plotted symbols will now remain the same size no matter the scale of the image. The symbol size will be that set in the 'Symbol Selector' (click the relevant symbol in the TOC to get to the 'Symbol Selector'). Now RC the image (not the symbols) and then 'Reference Scale' ‑> 'Set Reference Scale'.  The reference scale will be set to the current scale of the image. Now as you change the scale of the image, the size of the symbols changes; zoom in and the symbols will get larger. To revert to the original size of the symbols, RC the image and press the 'S' key twice.

PLOTTING STRUCTURAL SYMBOLS FROM A STRUCTURE .DBF FILE

RC 'campus Events' and select DATA ‑> Export data.  Export the new shape file as c:\arcampus\shape\'bedding.shp'. When asked “Do you want to add the exported data to the map as a a layer, answer ‘YES’.  Alternatively, ADD the stati.shp file as a new layer, change its name to e.g. ‘Bedding”.

Repeat to create .shp files for 'foliation1', foliation2, etc, and 'trap_dikes', or any other structural feature in the  'campus.dbf' file.

GROUPING LAYERS

The various structural layers can be grouped as a 'Structure Layers' Group by right clicking 'Layers' in the TOC and selecting 'New Group Layer'.  Click and drag the layers into the Group layer. Now turning off the Group Layer will turn off all the structure layers even if they are turned on individually.

PLOTTING STRUCTURAL SYMBOLS

DC 'bedding' to get 'Layer Properties'. Select Symbiology ‑> Categories ‑> Unique values.

In the values field select STRUCFEATU . Unselect the ‘All other values’ check box, click the ‘Add Value’ button and add the value 'subd' to the box.  Double click the symbol that appears to the left of 'subed' to get to the Symbol Selector. Click 'More Symbols' and click Geology 24K. Select the symbol to represent bedding and in the options box select size (40) and colour (orange) and make sure the angle is set to 270. Click OK.

In 'Layer Properties' click 'Advanced' ‑> rotation ‑> check the Geographic radio button, and in 'Rotate Points by angle...' select AZIMUTH. Click APPLY. Click OK and OK.

Repeat for 'foliation1', ‘foliation2’. 'dikes1, dikes 2', and faults.

PLOTTING STRUCTURAL LABELS

In 'Layer  Properties' select Labels. Check the 'Label features in this layer' box. In 'Method' select 'Define classes of features and label each class differently'.  In 'Class' select 'Get Symbol classes' to have the class value 'subed' entered as the class, and check 'Label features in this class. Enter 'DIP' as the Label Feld, and in the Placement Properties option box select low for 'Label Weight' and check 'Place overlapping labels'.

Repeat for 'foliation1', ‘foliation2’. 'dikes1, dikes 2', and faults.

The placement of the labels and their priority can be set in the Label Manager ‑ RC Layers ‑> Labeling ‑> Label Manager, etc.

DRAWING LINES (GEOLOGICAL BOUNDARIES)

RC 'Layers' and 'Add a New Group'. Call it ‘Lines'. 

Click the ArcCatalog icon in the Toolbar (icon to the left of the red 'Arc Toolbox' icon. Click File ‑> New ‑> Shapefile. Give the Shapefile the name ‘all_lines’, select the feature type as 'Polyline', and set the coordinate system. (If you intend to use the ET Geowizards function to convert intersecting polylines to polygons you must set the Coordinate system in all shapefiles to be added  to ArcMap (ET Geowizards will not assume that the shapefile has the coordinate reference of the Data Frame.)  It is convenient therefore to place the current coordinate project file in the Coordinate Systems folder in \Program Files\ArcGIS  ‑ when creating your first or any shapefile (Catalog ‑> File ‑> New ‑> Shapefile) and when adding the 'Spatial Reference', save the selected coordinate system to C:\Program Files\ArcGIS\Coordinate Systems.  When adding another shape file the 'Spatial Reference' can then be easily retrieved with the Select button.)

Click OK. The new ‘all_lines’ shapefile will appear in the shapefile list in the catalog. Click and drag the shapefile into the 'Lines' group in the TOC. 

To draw lines click View in the Main Menu Toolbar -> Toolbars and check the Editor option. The Editor toolbar will appear amongst the toobars at the top of the screen.

In the Editor selection menu click ‘Start Editing’. In the Start Editing window select which folder you wish to edit data from, and then click OK. On the Editor toolbar select ‘Create new feature’ in the Task menu, and ‘Lines’ in the ‘Target’ selection menu. Draw lines with the Sketch Tool (the pencil icon; the arrowhead next to the pencil is the Feature selection tool); double click to terminate drawing of the line. (To remove lines use the keyboard delete key.). (Note: the drawing tools in the Draw toolbar are used to draw in Data View or Layout View, and are not related to any shapefile or layer.)  Lines can be edited using the ‘Modify Feature’ Task tool.

When finished drawing lines, click ‘Save Edits’ and ‘Stop Editing’.

CONVERTING LINES TO POLYGONS AND TRANSFERRING SELECTED POLYGONS TO THEIR OWN LAYERS

Download ET Geowizards from:

http://www.ian‑ko.com/   ‑ ET Geo Wizards 

http://www.ian‑ko.com/ET_GeoWizards/UserGuide/et_geowizards_userguide.htm  ‑ ET Geo Wizards online guide

Unzip ETGeoWizardsXX.zip ‑ the file contains a single executable 

Run ETGeoWizardsXX.exe ‑ a simple installation wizard will guide you through the process. 

The best location to install the files is the hard disk where ArcGIS resides or your system disk 

In ArcMap 

Click the Tools menu and click Customize.

Click Add from file button 

Navigate to the folder where ETGeoWizards97_92.dll resides select it and click open 

In the added objects dialog box there will be a single object ‑ ETGeoWizards. Click OK 

Click the Commands Tab 

There will be new category ‑ ET GeoWizards ‑ click on it 

Drag the ET GeoWizards command to the Tool Bar.

           Create a temp folder for Geowizards – c:\geowiztemp – and when running Geowizards for the first time indicate that this is the temporary folder to be used by Geowizards.

With the ‘all_lines’ layer as the active layer draw your lines (boundaries) using the drawing tool on the Editor toolbar (Editor ‑> Start Editing ....). Save Edits and Stop Editing.

Create a Lithology group and a set of lithologic shape files e.g. 'granite' polygon shape file; add the shape files to the Lithology group.

Click ET Geowizards in the tool bar, and in the Geowizards menu select Polygon -> Build Polygon -> Go -> select the all_lines layer as the input and in “Specify output feature class or shapefile” enter c:\???\shape\allpolygons (where ??? is a predefined relevant folder) as the destination file.  Make sure the option to ‘clean’ the polylines is selected. Click Finish to initiate the convertion

With the 'allpolygons' layer active, start the Editor, and in Start Editing select the folder you want to edit. In 'Task' selection list select 'Create New Feature' and in 'Target' select the e.g. granite shape file. Click the polygon to be copied to the relevant layer (use Shift select to choose several polygons). RC and select Copy. RC and then Paste. Select Save Edits and Stop Editing. A copy of the selected polygon(s) representing granite bodies will now appear in the granite shape file.

To make the filled polygons transparent: RC Tools -> Effects -> indicate which layer you wish to make transparent, click the ‘Adjust Transparency’ icon, and adjust the transparency.

Note: 1) the attributes of the original polygon will not be copied with the polygon; 2)  when in Edit mode the ID fields of the lines and polygons can be manually edited; 3) when selecting a polygon by attributes use the format e.g. "SHORT_NAME" = 'AS'; 4) fields can be added to the attribute table of a shape file by going to Properties of the shape file ‑> Fields ‑> add a new field name (this can only be done after exiting any documents which contain references to the shape file).

What if I want to change the shape or position of part of a common boundary between two polygons where each polygon occupies its own layer (shapefile)?

Select Editor -> Start editing -> (select files from which you wish to edit data) -> More Editing tools -> Topology. Select  ‘Modify Edge’ under ‘Topology Task’ in the Task list (on the Edit toolbar). Left click the Map Topology icon (leftmost icon) on the Topology toolbar, and select the shapefiles to participate in the map topology, i.e. all the shapefiles containing features which include the lines you are going to change. Select the ‘Topology Edit’ tool in the Topology toolbar, and double click the line you wish to modify. Drag the node you wish to relocate to its new position, and single click in any blank space.  The line will now be relocated in all the polygon layers in which the line is a participatory drawing element. Save Edits and end the Editing session.  When you close ARCGIS the topological constraints set up during the Topological editing session will not be retained.  

IMPORTING LAYERS FROM AUTOCAD ‑ SUDBURY REGION SAMPLE

I have a .DWG file composed of layers representing geologic units hand‑copied as polygons on OGS map 2491 of the Sudbury region.  Each rock unit polygon has been placed on its own layer, with a separate layer for the vector 'hatch fill'.

There are also layers for faults, oriented bedding and structural symbols; bedding trends, rock unit boundaries, and younging directions; vector geographic entities such as reference coodinate points, coordinate grids, roads, railways, lakes, etc.; raster images such as airphotos, landsat images, and photographs; and text such as location names. 

Problem: to transfer the individual layers in Autocad to individual layers in ArcGIS9.

Procedure:

Freeze all the layers in Autocad except the layer for the e.g. Stobie polygon.


1) File ‑> Export ‑> 'File name' for the .DXF file e.g. map1 ‑>  'Save as type' 'Autocad R14 DXF' ‑> Save.  All the layers will be saved in the .DXF file (c. 10 Mb) but the file will record that only one layer is turned on.


2) File ‑> Export ‑> 'File name' for the .DXF file e.g. stobie ‑>  'Save as type' 'Autocad R14 DXF' ‑> Options ‑> check 'Select objects' ‑> OK ‑> Save ‑> select the objects to save (all or window the objects). Only the one layer (c. 35 kb) will be saved.


Load ArcMap and then ArcCatalog.


In the relevant directory of Arc Catalog, two 'map1' and two 'stobie' files/folders will be listed. 


The files represented by an uncoloured single document icon, contain in both cases the Stobie polygon (CAD drawing) without a coloured fill. If the folders are added as layers to ArcMap the layers will be titled map1.dxf and stobie.dxf. In the 'Drawing Layers' in the Properties of the map1.dxf layer are listed all the layers in the original .DWG drawing, whereas in the case of the stobie.dxf layer only the original stobie layer is listed.   

The folders represented by a blue coloured muti‑document icon (CAD Feature Dataset), contain lower level files referenced as annotated, multipatch, point, polygon and polyline folders. Adding the polyline and polygon data files to the TOC creates layers titled 'map1.dxf polyline' ('stobie.dxf, polyline') and 'map1.dxf polygon' ('stobie.dxf, polygon'), respectively. The former displays only the outline of the polygon whereas the latter displays both the polygon outline and its fill.

In all cases the layer data will not be georeferenced. In order to georeference the layers they will have to be exported as shapefiles using the option 'Use the same Coordinate system as the Data Frame' (will need to set the coordinate system of the Data Frame).

If the  map1.dxf and stobie.dxf files are erased, the map1.dxf and stobie.dxf folders will also be erased, implying that the files and folders are not independant data entries.

To conserve disk space, the best best option would seem be to export individual layers from Autocad as filtered ('select the objects to save' option) DXF files. Add the polygon file to ArcMap and resave to a new shapefile, e.g. stobiepolcoord. Clear all files except the latter.

MISCELLANEOUS

When you are in layout view and want to draw graphics on a data frame so they display with your data, it is not necessary to switch to data view first. Instead, click the Select Elements tool on the Draw toolbar and double‑click the data frame. This gives the data frame focus. Now when you draw graphics on the data frame, they'll be added to the data frame instead of to the map layout. Once you've finished, click outside the data frame with the Select Elements tool to unfocus the data frame. Graphics you add to a focused data frame in layout view will also show up in data view. However, any graphics you draw in layout view that are not being added to a focused data frame, only appear in layout view.

To add a Legend, North arrow, or scale bar, when in Layout mode, click insert ‑> North Arrow

Note from Deborah Lemkow of the GSC: “Regarding projections. Getting a projection through the data > export data option is not always the best way to go, as it isn't that accurate. For the students it is probably fine. However, if you were working as a consultant and doing mapping at 1:50 or more detailed, I wouldn't use it. Especially if you were dealing with discrete interfingering layers. Most of the people using GIS aren't as passionate about projection inconsistencies as maybe we are here at the GSC. The whole issue has really come to light now that the satelites can give us such great accuracy through the gps.”

Using GPS with ARCGIS9

RC Tools and select GPS to display the GPS toolbar. (Connect Belkin RS232 to USB converter before turning on the computer.) Click GPS Connection setup and set the com port (Use 'detect GPS Port" to determine port being used).  Make sure the datums correspond on the computer and the GPS unit.

Exporting a part of the image

The data in an ArcGIS World File has the form: 

           15.0000000000

            0.0000000000

            0.0000000000

          ‑15.0000000000 328848.5000000000 4888582.5000000000

where

15 = [X‑Scaling; meters]

0 = [Rotation] 

0 = [Translation] 

‑15 = [Y‑Scaling; meters] 

328848.5 = [UTM Easting of 1,1] 

4888582.5 = [UTM Northing of 1,1]

Correct plotting of the image also requires that the Tiff image have embedded as a Tag the information, e.g. 

10 S (UTM) = [UTM Grid Zone or Coordinate System PCS Number] 

NAD27 CONUS  =[Datum] 

The exported image will be whatever can be seen on the screen at the time of export.

To Export, click File ‑> Export Map ‑> the General tab at the bottom of the Export dialog box. 

Optionally, to add georeferencing information, check the Write World File box. This option is only available when you export while in data view and will create an additional file called a World File that contains information that is used in conjunction with the exported raster file to tell software where the image is located in the world. The file will have the same name as the image file and a file extension that is based on the first and last letters of the image's file extension plus the letter "w". (For example, if you create a TIFF image called "MyMap.tif, the world file will be called "MyMap.tfw".) The datum information will be retained in the Tiff file tag, and not in the World File.

At this stage you can also change the resolution of the exported map from the default value of 96 dpi.

Optionally, the TIFF file format has the ability to store georeferencing information internally. This is called a GeoTIFF. To create a GeoTIFF, click the Save as type dropdown arrow and click TIFF, click the Options arrow to expand the options, then click the Format tab and check the Write GeoTIFF Tags box. These options are only available when you export while in data view.

Reference points for campus image:

Top left 

477 700, 4761 900

Bottom left 
477 700, 4761 600

Top right 

478 000, 4761 900

Bottom right 
478 000, 4761 600
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